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Organisation and Conditions for Assessment 
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Organisation and Conditions for Assessment 
 
 
The assessment is designed to test the candidate’s ability to apply knowledge and understanding 
and practical skills, developed through study of the Relational Database Systems and Using 
Information Units.  The mark out of 60 should be submitted to the SQA unscaled.  This will be 
combined with the examination mark out of 140 to establish the candidate’s overall grade of 
award.  This mark should also be used in conjunction with internal examination marks or other 
evidence in the preparation of a candidate’s estimated grade of performance. 
 
The notional design length for the assessment is 8–10 hours.  However, a candidate may be 
permitted additional time if required. 
 
The assessment is to be undertaken under “open book” conditions, but under the supervision of a 
teacher or lecturer to ensure that the work submitted is the candidate’s own work.  The teacher or 
lecturer may give the candidate guidance and/or help if requested.  Any such help should be 
reflected in the marks awarded.  Once the task has been completed and marked, it should not be 
returned to the candidate for further work. 
 
These instructions are designed to be used in conjunction with data files provided with the 
electronic distribution of the task.  These can be downloaded from the SQA secure website. 
 
Two versions of a database are being supplied this year.  It is essential that candidates are 
issued with the correct version at the appropriate times.  They must not be given access to 
the second version until they have submitted answers to prior tasks. 
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Special Arrangements for Higher Coursework 2010-2011 
 
Centres are asked to pay special attention to the following 
arrangements. 
 
 
Candidates are not required to spend time entering data into a database.  Instead, the data should 
be prepared beforehand and provided to candidates by the centre. 
 
To facilitate this, Microsoft Access (2003 format) and Filemaker (v.7) files as well as a text (tab) 
delimited file have been provided.  It is intended that candidates will be provided with two 
versions of the database. 
 
The first database contains three of the tables of the system; Venue, Band and Promoter.  Each 
table will have all attributes correctly implemented although the tables will not be related.  
Candidates will be required to create the Gig table from the completed data dictionary and then 
set up the relationships between all the tables.  Candidates will be required to submit a printout of 
the Documenter (or equivalent) of the Gig table only as evidence for Task 2(a).  Evidence for 
Task 2(b) could be generated from the Documenter again (selecting only Relationships in the 
options) but the evidence must show three correct one-to-many relationships.  Candidates will not 
use their database structures to complete Tasks 3-5.  Instead, centres should issue candidates with 
the second, fully populated database. 
 
The second database will be a complete implementation of the system.  This will include all 
validations, relationships etc – ie an exact implementation of the data dictionary provided to 
candidates at Task 2.  This working database should be issued to candidates after Task 2 has been 
submitted.  Candidates must use this working database to complete Tasks 3-5. 
 
Microsoft Access and Filemaker files are provided.  Centres using other systems will require to 
create both versions of the database from the tab separated file provided.  This file can also be 
used if centres encounter any difficulties with the supplied Access or Filemaker databases. 
 
Additional notes follow which detail how candidate evidence is to be generated. 
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Notes: 
 

Candidates should be given a copy of the marking grid from Section 3 (not the detailed 
marking instructions) before starting the task so that they are aware of the mark distribution 
for each part. 

The entire Coursework Task consists of six tasks.  Centres should take note of the points 
detailed below for each task. 

Task Evidence 
1 Hardcopy of proforma provided or can be produced by the candidate.  Task 1 must be 

completed and data dictionary handed in for marking before the materials for  
Task 2 are issued. 
 

2 (a) Documenter (MS Access) printout or equivalent showing table structure for the Gig table 
only – ignore “Format” for marking purposes. 
 

2 (b) Printout showing correct cardinality of relationships (Documenter in Access can be used 
to produce only the relationships information through the options). 
 
o In FileMaker Pro8, to get a printout of the design, candidates should 

adhere to the following instructions. 
 

(1) Select the “Define” option from the File menu and then select the 
“Database” option from the sub-menu. 

(2) Click on the Tables tab. 
(3) Highlight both tables by clicking on the name of the first table then 

holding down the shift key and clicking on the other table. 
(4) Click on the Print button. 

 
o In MS Access, to get a printout of the design, candidates should adhere to 

the following instructions.   
(1) Select the “Analyze” option from the Tools menu and then select 

the “Documenter” option from the sub-menu. 
(2) Select the table(s) required and then click Options button. 
(3) Make sure that the following options are checked/selected: 

• Include for Table 
 Properties 
 Relationships 

• Include for Fields 
 Names, Data Types, Sizes and Properties 

• Include for Indexes 
 Names and Fields 

(4) Required table design is displayed on screen and can be printed. 
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Task 2 (b) also requires a printout or hardcopy of the relationships. 

o Printing Relationships in FileMaker 8. 
(1) Select the “Define” option from the File menu and then select the 

“Database” option from the sub-menu. 
(2) Click on the Relationships tab then click on the Print button. 

 
o Printing Relationships in Access 

(1) Open the Relationships window. 
(2) Select the “Print Relationships” option from the File menu. 

3 Printout of report. 
 

4 Printout of report and printout of screenshots showing two sorts. 
 

5 Hardcopy that clearly shows use and details of macro or script (again, available through 
Documenter in Access – simply change options in dialogue box). 
 

6(a) Printout of style definitions. 
 

6(b) 
 

Brochure 

6(c) Printed 8 page brochure. 
 
Screen shots with style area or equivalent to show applied styles. 
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Coursework Task: GoToGigs 
 
 
Higher Information Systems Coursework Task 2010-2011 
 
Background 
 
GoToGigs is an organisation that owns and manages a number of concert venues throughout 
Scotland.  They have venues in Aberdeen, Dundee, Edinburgh and Glasgow.  All venue details 
are stored as part of a relational database in a table called Venue.  Venue names are unique.  As 
well as the venue name and address, the following details are stored: 
 
• Seating Capacity (between 1,000 and 12,000) 
• Hire Cost (between £750 and £9,850) 
 
Promoters of bands register with GoToGigs and their contact details are stored in a Promoter 
table.  Promoters are allocated a unique ID.  Promoters charge each band they represent a fixed 
commission fee for every gig they book, based on a percentage of ticket sales.  No promoter 
charges more than a 10% fee. 
 
Bands are represented and managed by promoters.  A band can only be managed by one 
promoter, although the same promoter can be responsible for many bands.  The details of the 
bands that each promoter represents are stored in a Band table.  Band names are unique. 
 
When a promoter wants to arrange a concert for one of the bands they represent they negotiate 
with GoToTickets to decide which venues will be played, which dates will be played, the price of 
tickets etc.  Tickets are priced between £15 and £65.  No venue can host more than one band on 
any given date.  These details are stored in table called Gig. 
 
Bands, promoters and customers attending concerts frequently make requests to GoToGigs for 
specific information. 
 
GoToGigs use a relational database to manage this information. 
 
The relational data model is shown on the next page. 
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Entities 
 
The resulting data model is shown below where primary keys are shown in bold and underlined, 
while asterisks (*) indicate foreign keys.) 
 
Promoter  
 
Band (BandName, NumberofMembers, YearFormed, PromoterID*) 
 
Venue (VenueName, VenueAddress, VenueCity, SeatingCapacity, HireCost) 
 
Gig (VenueName*, Date, BandName*, CostPerTicket, TicketsSold) 
 
The entity-relationship diagram for the system is shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Promoter ID, PromoterName, PromoterPhone, CommissionRate) 

Venue Promoter Band Gig 
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A data dictionary has been produced prior to implementation in a relational database.  Part of this 
is shown below. 
 
Data Dictionary 
 

Entity Attribute PK/ 
FK 

Data 
Type/Size 

Unique Required Validation Format 

Promoter PromoterID PK Number Y Y   
 PromoterName  Text (20) N Y   
 PromoterPhone  Text (15) Y Y   
 CommissionRate  Number N Y <=0·10  
        
Band BandName PK Text (30) Y Y   
 NumberofMembers  Number N Y   
 YearFormed  Number N Y   
 PromoterID FK Number N Y Lookup from Promoter  
        
Venue VenueName PK Text(20) Y Y   
 VenueAddress  Text (40) Y Y   
 VenueCity  Text (15) N Y   
 SeatingCapacity  Number N Y >=1000 and <=12000  
 HireCost  Number N Y >=750 and <=9850  
        
Gig VenueName   N Y   
 Date  Date N Y   
 BandName   N Y   
 CostPerTicket  Number N Y   
 TicketsSold  Number N Y   

 
 
 
Task Evidence Required 
1 Your teacher/lecturer will provide you with a partially 

completed data dictionary for the Gig table. 
 
Using the background information provided, complete the data 
dictionary for the Gig table by making appropriate entries in the 
shaded areas as indicated. 
 

Completed data 
dictionary 
(Proforma 1) 

 
You must now submit your answer to Task 1 to your teacher/lecturer. 
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Before attempting the tasks in this section ask your teacher/lecturer for a completed data 
dictionary.   
 
You will also need access to pre-prepared database tables.  
 
You MUST complete tasks in the sequence indicated. 
 
 
Task Evidence Required 
2 Database tables have been created for the Venue, Promoter and Band tables. 
 (a) Using the completed data dictionary issued by your 

teacher/lecturer, create the Gig table.  You should pay 
particular attention to: 

• data type (text size) 
• required 
• validation 
• primary and foreign keys 

 

Hardcopy (printout or 
screenshots) of table 
structure including 
field types, validation 
checks etc. 

 (b) Set up/edit the relationships between all the tables as 
indicated by the entity-relationship diagram. 

Hardcopy (printout or 
screenshots) of 
relationships between 
tables – evidence 
must show correct 
cardinality 

 
You must now submit all hardcopies for Task 2 to your teacher/lecturer. 
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Ask your teacher/lecturer for the complete database.  This database must be used to carry 
out Tasks 3-5. 
 
A music magazine had made a request for information from GoToGigs concerning the popularity 
of venues for concert goers.  They wanted to publish a list of the most popular cities in terms of 
total number of tickets sales.  GoToGigs prepared the following report. 
 

 
 

The magazine now wants a similar list but this time it should show the total revenue generated 
by ticket sales for each city.  The list should be ordered from the city with the largest revenue.  
The revenue is calculated as the sum of tickets sold multiplied by the cost per ticket. 

 
Task Evidence Required 
3 Using appropriate database functions, create a report that 

displays the total revenue generated by gigs played at each of 
the four cities.  The report data should be ordered with the city 
with the biggest revenue first.  Your report should include only 
the name of the city and the total amount of revenue generated.  
The revenue should be displayed in currency format. 
 

Printout of 
report/layout 
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GoToGigs have been monitoring which of the promoters has been arranging the most concerts 
and created the report shown below. 
 

 
 

They have decided that the report does not provide enough detail and have asked you to improve 
the information shown by displaying a breakdown of how often each promoter arranges gigs in 
each of the four cities.  A sample layout has been provided below. 
 

 
 
Task Evidence Required 
4 Create a report as follows: 

 
• Show, for each promoter the number of gigs they have 

arranged in each of the four cities. 
• The data for each promoter should be arranged with the 

city booked most often first. 
• Where two or more cities have been used the same 

number of times they should be also sorted. 
• Include the promoter name, the name of each city, the 

number of times each city has been used for gigs and the 
total number of gigs for each promoter. 

Printout of 
report/layout 

(no requirement for 
report to be sorted by 

Promoter) 
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GoToGigs think it would be helpful to be able to view a list of gigs that are on at each venue.  
They have decided to create a Venue Selector form/layout where each venue is listed.  When a 
specific venue is chosen the Venue select screen closes and is replaced by a list of all gigs at the 
chosen venue.  The list of gigs also includes a link back to the Venue Selector screen, as is shown 
in the 2 sample screens below using “The Shack” venue as an example. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Fig (a) Venue Selector Form Fig (b) Gigs at chosen venue 
 
 
Task Evidence Required 
5 Your GoToGigs database already includes the Venue Selector 

form shown in Fig (a) above. 
 
Choose one venue and create, using a macro or script, a 
navigational link to a separate form/layout that shows only the 
gigs from that venue, as shown in Fig (b).  Do not include the 
TicketsSold attribute.  Include on this form/layout a link back to 
the Venue select screen, again through the use of a macro or 
script. 
 
Each navigational link should close the current form/layout 
and open the selected form/layout. 
 

Printout of 
report/layout 

 
Printout of macros/ 

scripts used to control 
navigational features 
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GoToGigs want to create a brochure about their company.  The brochure will have eight pages. 
 
It will contain a cover page, a contents page, details about the company, information pages about 
the venues in each city and a summary of events for upcoming months. 
 
The brochure design is shown in the style required in Appendix 3 and the specification of each 
page is shown overleaf. 
 
GoToGigs use their own house style on all printed documents.  You must implement this house 
style in the brochure. 
 

• Style 1: Main Text 
o Any serif font, 12 point, plain style, text colour black, line spacing 1.5 

• Style 2: Heading 1 
o Any sans serif font, 18 point, plain style, text colour red 

• Style 3: Heading 2 
o Same font as style 2, 14 point, italic style, text colour red 

• Style 4: Table text 
o Same font as style 1, 10 point, plain style, text colour black 

 
Your teacher/lecturer will issue the text required for the brochure and the images required for the 
cover page and watermark. 
 
You must create the brochure to the supplied specification and print a copy.  You should also 
provide evidence of implementing the house style. 
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Brochure Specification

Page Heading  
(using Style 2) 

Subheadings 
(using Style 3) 

Watermark 
Image 

Header Page 
number 

Images Other 

1 www.gotogigs.co.uk None No None No Lettering image 
Coverpage image 
 
 

Border 

2 Contents None Yes None Yes  Automatically 
generated table of 
contents 
 

3 Company Information None Yes None Yes Guitarist image 
 
 

Text Wrap 
 

4 Aberdeen Collasia Palace 
The Cut 
The Turnaround 

Yes 24-hour ticket office at www.gotogigs.co.uk Yes  
 
 
 

 

5 Dundee The Nightshade 
Timeout Club 
Upstairs Downstairs 

Yes Same as page 4 Yes  
 
 
 

Footnote about 
capacity 

6 Edinburgh The Dome 
The Jozone Layer 
The Meeting Point 
The Office 

Yes Same as page 4 Yes   

7 Glasgow The Gatehouse 
The H2O Fountain 
The Shack 
The Shed 

Yes Same as page 4 Yes   

8 Programme of Events November 2010 
December 2010 

No Same as page 4 Yes Landscape 
Two Columns 

Tables (using Style 4) 
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Task Evidence Required 
6 You are going to create the brochure using the files provided by 

your teacher/lecturer. 
 

 

 (a) Define the four styles required to implement house style. 
 

Printed definition of 
styles used. 

(b) Create the brochure. 
 
In creating the brochure you must: 
• Insert the coverpage at the beginning with the 

correct images, text and layout. 
• Insert the image on the company information page 

and text wrap as shown. 
• Apply the defined styles in the appropriate places.  

Main text on each page uses style 1, headings use 
style 2, subheadings use style 3 and the tables on 
the back page use style 4. 

• Change the programme of events page to landscape 
with two columns. 

• Add a footnote reference beside the 2000 capacity 
of Upstairs Downstairs in Dundee.  The footnote 
should read “Currently 1750, extended capacity to 
be completed by May 2011”.  This extra 
information should be included at the bottom of the 
page referenced by * symbol. 

• Create the breaks between pages and sections as 
required. 

• Automatically generate the table of contents for 
page 2 which includes page headings, subheadings 
and page numbers. 

• Add the watermark image on the pages specified. 
• Include the words “24-hour ticket office at 

www.gotogigs.co.uk” aligned to the right in the 
header on the pages specified. 

• Insert the page numbers in the footer on the pages 
specified. 

 

Printed copy of 
brochure and screen 

shots out outline 
showing applied 

styles 

(c) Print the brochure and evidence of using the stylesheet.  It 
does not need to be printed in colour. 
 

 

http://www.gotogigs.co.uk/�


Scottish Qualifications Authority 20 
Coursework Task  
Higher Information Systems 2010/2011 

 
 
 
 
 
 
 
 
 
 

Section 3 
 
 
 
 
 
 
Marking Grid 
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Marking Grid 
 
 
Name   Date     
 
 
Task Possible 

Marks 
Actual  
Marks 

Evidence Comment 

1. 6  Completed data 
dictionary 

 

2.(a) 4  Printout of table 
structure 

 

2.(b) 2  Printout showing 
relationships 

 

3. 6  Printout of report  

4. 8  Printout of report  

5. 4  Printout of 
macros/scripts 

 

6.(a) 4  Printout of style 
definitions 

 

6.(b) 3  Cover page  

 2  Insert Image  

 4  Printout of applied 
styles 

 

 2  Programme of 
Events page 

 

 3  Footnote  

 2  Pagination  

 3  Table of contents 
page 

 

 2  Watermarks  

 4  Headers/Footers  

6.(c) 1  Printout of 
brochure 

 

 60 
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Appendix 1 
 
Task 1 Proforma 
 
 

Name  

Data dictionary for Gig entity 

Attribute PK/FK Data 
Type/Size 

Un
iq
ue 

Re
qd Validation 

VenueName   N Y  

Date  Date N Y - 

BandName   N Y  

CostPerTicket - Number N Y  

TicketsSold - Number N Y - 
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Appendix 2 
 
Completed Data Dictionary 
 
Only to be issued after completion and submission of Task 1 
 
Entity Attribute PK/ 

FK 
Data 
Type/Size 

Unique Required Validation 

Promoter PromoterID PK Number Y Y  
 PromoterName  Text (20) N Y  
 PromoterPhone  Text (15) Y Y  
 CommissionRate  Number N Y <=0·10 
       
Band BandName PK Text (30) Y Y  
 NumberofMembers  Number N Y  
 YearFormed  Number N Y  
 PromoterID FK Number N Y Lookup from Promoter 
       
Venue VenueName PK Text(20) Y Y  
 VenueAddress  Text (40) Y Y  
 VenueCity  Text (15) N Y  
 SeatingCapacity  Number N Y >=1000 and <=12000 
 HireCost  Number N Y >=750 and <=9850 
       
Gig VenueName PK/FK Text(20) N Y Lookup from Venue 
 Date PK Date N Y  
 BandName FK Text(30) N Y Lookup from Bank 
 CostPerTicket  Number N Y >=15 and <=65 
 TicketsSold  Number N Y  
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Appendix 3 
 
 
 
 
 
 
 
Brochure Design 
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Company InformationCompany InformationCompany InformationCompany Information    
GoToGigs owns and manages a number of concert venues 

throughout Scotland. We have venues in Aberdeen, 

Dundee, Edinburgh and Glasgow.  

The company was founded in January 2005 and have a 

proven record of success over the years. 

  

We have been responsible for some of the best concerts and shows in 

Scotland over the last few years, gradually developing our reputation as 

the first choice concert organisation in the country. 

 

If you are the promoter for a performer or band, then you can register with 

us by contacting our head office on 01234 567899. 

 

If you require information about any of our venues, then please read the 

following pages outlining the venue addresses, seating capacity and hire 

costs.  

 

For information about forthcoming gigs, such as dates, ticket prices and 

ticket sales then visit our website at www.gotogigs.co.uk 
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AberdeenAberdeenAberdeenAberdeen    

Collasia Palace 

The Collasia Palace is located near the sea front in Aberdeen. It is an ideal 

venue for small, intimate concerts or debut performances. 

Address Unit 12A Northern Exhibition Centre 

Capacity 1000 

Hire Cost £750 

The Cut 

The Cut is Aberdeen’s largest venue, located to the east of the city centre, 

within easy reach of the town and its many hotels.  It has fantastic 

acoustics and is especially suited for rock bands. 

Address Granite Park 

Capacity 12000 

Hire Cost £9500 

The Turnaround 

The Turnaround is located in the north of the city.  It is close to the 

university campus, making it an ideal venue for young people.  

Address Hilton Park 

Capacity 4500 

Hire Cost £3250 
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DundeeDundeeDundeeDundee    

The Nightshade 

The Nightshade sits on the banks of the Firth of Tay with a splendid 

panoramic view of the Tay Bridge.  It is a good, medium sized venue 

suitable for all types of concerts.   

Address 7 Discovery Way 

Capacity 3500 

Hire Cost £2200 

Timeout Club 

The Timeout Club is a new purpose-built arena, located on the east of the 

city in a new multi-purpose complex with excellent transport links to the 

city centre.  

Address The Grange 

Capacity 8800 

Hire Cost £5300 

Upstairs Downstairs 

Upstairs Downstairs is ideally situated as a student venue, within easy 

reach of both the University of Dundee and Abertay University.  It is 

currently undergoing some refurbishment to increase its seating capacity.  

Address 26 Douglas Street 

Capacity 2000* 

Hire Cost £1850 

                                      
* Currently 1750, extended capacity to be completed by May 2011 
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EdinburghEdinburghEdinburghEdinburgh    

The Dome 

The Dome is located in a development at the West End of Princes Street.  

It is one of the city’s largest venues and is well suited to rock bands.  

Address West End Park 

Capacity 10500 

Hire Cost £9850 

The Jozone Layer 

The Jozone Layer has recently opened on the west side of the city, with 

excellent transport links into Edinburgh, Glasgow and Stirling.  

Address 2 Crawling Place 

Capacity 5500 

Hire Cost £4450 

The Meeting Point 

The Meeting Point has become one of the busiest venues in Edinburgh as 

it is very centrally located, close to all amenities.  

Address 16 Royal Mile 

Capacity 9500 

Hire Cost £8700 

The Office 

The Office has been converted from a former government building into a 

modern, exciting new venue offering a large capacity for concerts of all 

types .  

Address 34 Crow Road 

Capacity 11500 

Hire Cost £9750 
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GlasgowGlasgowGlasgowGlasgow    

The Gatehouse 

The Gatehouse offers an intimate setting for small gigs  

Address Mains Estate 

Capacity 1000 

Hire Cost £800 

The H2O Fountain 

The H20 Fountain is ideally situated in the centre of Glasgow, within easy 

reach of all bus, train and underground services.  

Address 12 Hope Street 

Capacity 2500 

Hire Cost £1200 

The Shack 

The Shack offers a modern arena with excellent facilities in a central 

location, close to all transport links.  

Address 221 Lighthouse View 

Capacity 11000 

Hire Cost £8500 

The Shed 

The Shed is located on the south side of Glasgow, close to the River Clyde.  

It is developing a reputation as an excellent venue for break through 

bands. 

Address 374 Main Street 

Capacity 8500 

Hire Cost £7500 
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Programme of EventsProgramme of EventsProgramme of EventsProgramme of Events        

November 2010 

Date Band Venue Town 

01/11/2010 The Daredevils The Shed Glasgow 

02/11/2010 The Daredevils The Shack Glasgow 

10/11/2010 M & M The Jozone Layer Edinburgh 

15/11/2010 Cookin Mama The H2O Fountain Glasgow 

16/11/2010 Shocking Pink The Nightshade Dundee 

18/11/2010 Koko The Dome Edinburgh 

23/11/2010 BoyzAloud Upstairs Downstairs Dundee 

26/11/2010 Koko The Cut Aberdeen 

 

December 2010 

Date Band Venue Town 

07/12/2010 The Crying Babies The Nightshade Dundee 

07/12/2010 The Running Men Collasia Palace Aberdeen 

10/12/2010 Fruit Cocktail The Shed Glasgow 

13/12/2010 Mortified Collasia Palace Aberdeen 

16/12/2010 The Running Men The Gatehouse Glasgow 

17/12/2010 The Pookys The Shack Glasgow 

21/12/2010 Grey Eyed Beans The Cut Aberdeen 

23/12/2010 The Running Men The Nightshade Dundee 

31/12/2010 BABA The Nightshade Dundee 

31/12/2010 A Thousand Words The Meeting Point Edinburgh 

31/12/2010 Adding Owls The Jozone Layer Edinburgh 
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